
 

The most up-to-date compatibility information is on the 
 

 
Upgrade Complexity 

 From prior version: Easy � 

Enhancements and revisions in Adagio GridView 9.

New Features 

♦ Added ability to show a subtotal and page 
new 'Format Report' option on the Filters dialog when a Sort Sequence has been applied.
on the row number. 'Set Page Break' and 'Clear Page Break' have been added to right mouse context menu.

♦ When on any cell in a row, use CTRL+B to toggle
number. 

♦ Added the option 'Suppress Other' to Summary Filters when using Top/Bottom "n" so that the 

♦ Columns may now be formatted to contain hyperlinks to any document with an associated program in Windows, such as PDFs, Word 
documents or JPG image files (9.0F added hyperlinks but 
Hyperlink' from the column context menu 
characters must be replaced with forward slashes. For example, 'C:/SOFTRAK/DATA/ICBKHUNI001.jpg' to display the image 
associated with the 'Women's Via Montega hybrid' item in the Inventory sample data. Note that the Image File field on the Ima
in the item cannot be used directly as the path has backslashes. Therefore 
"IC", trim({Item #}), ".jpg"). Click in the cell and the PDF is opened with default PDF viewer.

♦ Added function FULLFILENAME for use with hyperlinks
example: FULLFILENAME("x:\Softrak\Data

♦ Excel Direct now transfers hyperlinks to the 

♦ Added function FILEEXISTS(S). Use to test for the existence of a file. 
Note: backslashes in the path must be replaced with forward slashes.

♦ Excel Direct now sends Page Scaling and

♦ Additional Print Setup and Page Setup options (ex. landscape, grid lines, centre on page) in the view are now sent to the Exc
by Excel Direct. 

♦ In the File Properties dialog (right-click top left cell), wildcard characters 
characters for single files. For example "GLPST" is now shown instead of "GL???" for the G/L Posted Transactions file.

♦ Added function DATESTART (”Spec Code” [,”C”|”F”])
and the session date used to log into GridView, for 

♦ Added function DATEEND (”Spec Code” [,”C”|”F”])
the session date used to log into GridView.
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Release Notes 

date compatibility information is on the Product Compatibility Info

Adagio® 
BankRec 8.0A – 8.1D 
Checks 8.0A – 8.1B 
Contacts 8.0A 
DataCare 8.1A - 9.0A 
ePrint 9.0A 
FX 8.0A – 9.0B 
GridView-RW 9.0F 
Inventory 8.0A – 8.1D 
Invoices 8.0A – 9.0B 
JobCost 8.1A - 8.1C 
Lanpak 9.0E 
Ledger 8.0A – 9.0D 
MultiCurrency 8.0A – 8.1B 
OrderEntry 8.0A – 8.1E 
Payables 8.0A – 8.1E 

 
Purchase Orders
PurchaseOrders 8.1C
Receivables 8.0A
SalesAnalysis 8.0A
SalesCQ 8.1A 
Time&Billing 8.0A
 

Other  
Any product for which an Adagio Data
     Dictionary has been created
Excel Workbooks
Island Microsystems p
DSN / UDL data sources
MS Office 2003, 2007
MS Windows XP

Enhancements and revisions in Adagio GridView 9.1A (2013.04.02) 

Added ability to show a subtotal and page break on change of the first level sort sequence for Filters with a Sort Sequence
new 'Format Report' option on the Filters dialog when a Sort Sequence has been applied. The page break is indicated by a red line 

k' and 'Clear Page Break' have been added to right mouse context menu.

se CTRL+B to toggle a page break on or off. The page break is indicated by a red line on the row 

Added the option 'Suppress Other' to Summary Filters when using Top/Bottom "n" so that the **Other** row is not displayed.

Columns may now be formatted to contain hyperlinks to any document with an associated program in Windows, such as PDFs, Word 
(9.0F added hyperlinks but only to web URLs or email addresses). Use 'Make Hyperlink / Remove 

 and format the column as text. The cell must contain a filename with full path. Backslash 
must be replaced with forward slashes. For example, 'C:/SOFTRAK/DATA/ICBKHUNI001.jpg' to display the image 

associated with the 'Women's Via Montega hybrid' item in the Inventory sample data. Note that the Image File field on the Ima
the path has backslashes. Therefore a formula must be used: STRCAT

trim({Item #}), ".jpg"). Click in the cell and the PDF is opened with default PDF viewer. 

Added function FULLFILENAME for use with hyperlinks. Use instead of STRCAT to form the path when a “
Data\SoftPDF\", {Cust #}, "_OE_I____", TRIM ({Doc #}",".PDF"). 

the Excel sheet. 

ILEEXISTS(S). Use to test for the existence of a file. This is useful when used with hyperlinks to document files.
Note: backslashes in the path must be replaced with forward slashes. 

and Page Breaks to the sheet and handles $D in Header/Footer. 

Additional Print Setup and Page Setup options (ex. landscape, grid lines, centre on page) in the view are now sent to the Exc

click top left cell), wildcard characters (??? or +++) in the Name are replaced with the actual 
characters for single files. For example "GLPST" is now shown instead of "GL???" for the G/L Posted Transactions file.

”Spec Code” [,”C”|”F”]). It returns the start of period date based on the Financial Reporter spec code 
date used to log into GridView, for either the Calendar or Fiscal year. 

”Spec Code” [,”C”|”F”]). It returns the end of period date based on the Financial Reporter spec code and 
the session date used to log into GridView. 
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04.02) 

Product Compatibility Info link at www.softrak.com. 

Orders for Adagio 8.1A, 8.1B 
PurchaseOrders 8.1C 

8.0A – 9.0C 
8.0A – 9.0B 
- 8.1C 

Time&Billing 8.0A – 8.1C 

Any product for which an Adagio Data 
Dictionary has been created 

Excel Workbooks 
Microsystems products 

DSN / UDL data sources 
MS Office 2003, 2007, 2010 

XP, Vista, 7, 8 

Filters with a Sort Sequence. Click the 
The page break is indicated by a red line 

k' and 'Clear Page Break' have been added to right mouse context menu. 

is indicated by a red line on the row 

**Other** row is not displayed. 

Columns may now be formatted to contain hyperlinks to any document with an associated program in Windows, such as PDFs, Word 
. Use 'Make Hyperlink / Remove 

. The cell must contain a filename with full path. Backslash 
must be replaced with forward slashes. For example, 'C:/SOFTRAK/DATA/ICBKHUNI001.jpg' to display the image 

associated with the 'Women's Via Montega hybrid' item in the Inventory sample data. Note that the Image File field on the Image tab 
STRCAT("C:/SOFTRAK/DATA/", 

when a “\” is required. For 

seful when used with hyperlinks to document files. 

Additional Print Setup and Page Setup options (ex. landscape, grid lines, centre on page) in the view are now sent to the Excel sheet 

(??? or +++) in the Name are replaced with the actual 
characters for single files. For example "GLPST" is now shown instead of "GL???" for the G/L Posted Transactions file. 

date based on the Financial Reporter spec code 

of period date based on the Financial Reporter spec code and 
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♦ Added function DATEIN ({Date},”Ledger Spec Code” [,”C”|”F”]). Used to test for the existence of the date stored in the Date 
calculated column within the range defined by the STARTDATE and ENDDATE calculated columns. Returns 1 if the date exists 
within the range. Alternate use of function is DATEIN ({Date}, {Start Date}, {End Date}). Returns 1 if Date falls in the specified date 
range. 

♦ Added function INCLUDEAMOUNT ({Number}, {Date}, ”Ledger Spec Code” [,”C”|”F”]). Used to test for the existence of the date 
stored in the Date calculated column within the range defined which is based on the session date. Returns the value of {Number} if 
the date exists within the range otherwise 0. Alternate use of function is INCLUDEAMOUNT ({Number}, {Date}, {Start Date}, {End 
Date}). Returns {Number} if the date falls in the specified range, 0 otherwise. 

♦ Added 'Tile In Place' to the Window menu. It proportionally tiles views in a workspace as long as they are close to what you want and 
are not overlapped. This is useful when opening a workspace originally saved on a machine with a different size monitor. The 
shortcut for 'Tile In Place' is Ctrl-T (which in previous versions was used for 'Tile Horizontal'). 

♦ Added control resizing for the entire workspace. Click the Ctrl button and size the GridView window. The views in the workspace will 
be sized proportionally. If you press ESCAPE before releasing the mouse button the change will be discarded. 

♦ Added File | Export to | XML Data Only... (i.e. without formatting of any sort). 

♦ Added new command line parameter for use with XDViews: 
 
/XDN - Exports view without formatting and any hyperlinks. 
/XDS - Runs XDViews in 'silent' mode (no user interface displayed for GV or Excel). 
/XDO:<workspace> - Exports column names using ODBC compliant fieldnames (no spaces or special characters). 

♦ The column title now respects the Horizontal alignment setting (left, center, right) in Add Formatting, Align tab. In previous versions 
only the data in the column respected the setting. 

♦ Added option 'Lock Toolbars" to View | Customize | Toolbars. Prevents the toolbar from being moved or modified. 

♦ Help | Active Users now shows the date and time users logged into Adagio if you are logged in as SYS (and not running in RW 
mode, if GridView-RW is installed). You can sort the grid by any column. 

♦ The Gather Files for Support function now includes the ADSPROF.xxx file and external files (xls?, dbf, dsn, udl) if used. It now 
retains the original date and time of the files. 

♦ Added "Registered to: <Company Name>" to the status line.  

♦ New splash screen with an updated look.  

♦ In earlier releases of Adagio we added the ability for Excel Direct to create a CSV file for use by other spreadsheet applications, such 
as Apache OpenOfficeTM Calc, at sites that did not have Excel installed. The spreadsheet program was launched and opened the 
CSV file created. Excel Direct can now use Windows "automation" (inter-process communication) to send data to other spreadsheet 
applications, the same way it interfaces to Excel, allowing all formatting to be retained in the resulting sheet. OpenOffice 3.3 or later 
and LibreOffice® 3.3 or later are supported. This interface must be manually enabled. The file SSI2XL.INI must exist in 
\softrak\system and must contain the section [Initialization] with an entry <computer name>-UseOpenOffice=1, where <computer 
name> is the name of the machine that this entry references. Refer to the Readme Help for further details. 

Problems Fixed 

♦ There was a problem in GridView 9.0F when a view having multiple sort columns was summarized. The column being summarized 
was not reported properly. 

♦ The BEGINWEEK() function reported the wrong date when the week began in the previous month, depending on the system date 
and session date used. 

♦ If you clicked the 'x' in the window title bar to exit a view, then responded Cancel to the prompt asking if you want to save the data, 
then refreshed the view, the error message "The ADS function: <table> returned unexpected error number 2111." was displayed. 

♦ Corrected problem where the wrong result was returned from GETFIELDVALUE when referencing an Excel sheet. 

♦ You are now prevented from deleting a Calculated Column that is used by another Calculated Column, which caused the program to 
crash in previous versions. 

♦ Field Properties now recognizes fields of Type PERCENT. 

♦ Installs an updated version of the Adagio Data Source (ADS) that corrects the OpLocks Setting shown in station log files <computer 
name>.log in \Softrak\System\StationLogs. It was reported as Enabled instead of Disabled in some cases. 
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Enhancements and revisions in earlier versions of Adagio GridView 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

To install Adagio GridView, you need the serial number and install code from the download email sent to you by Softrak Systems. 

If you are installing an upgrade, you need the serial number and install code from the upgrade download instruction email. A previous 
version of Adagio GridView should already be installed on your computer before installing the upgrade. If a previous version is not 
already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter 
the serial number and install code from your previous version. 

To install Adagio GridView (or an upgrade), run the program file you downloaded. Once the install program is running you can click the 
View button for detailed instructions in the Readme help. If Adagio GridView is installed on a network, you must also do a workstation 
install for each workstation running the product. Refer to the manual or Readme help for workstation install instructions. 

Upgrading to this Version  Upgrade Complexity:  Easy � 

Adagio GridView 9.1A requires Adagio Lanpak to be version 9.0E or higher. Do not install this upgrade before you have installed 
Lanpak 9.0E if you require multiple users in Adagio GridView. If you have any prior version Lanpaks installed but no 9.0E Lanpaks, the 
Adagio GridView install will warn you. 

Adagio GridView-RW 9.1A (if used) is required for use with GridView 9.1A. Earlier versions of GridView-RW are not compatible. Do not 
install this upgrade if you do not also have your GridView-RW 9.1A upgrade available to install. 

Views and Workspaces in 9.1A use a new file format. Views and Workspaces created with earlier versions will be automatically 
converted. Views and Workspaces created with 9.1A cannot be used in earlier versions. If 9.1A Views or Workspaces are opened 
with earlier versions, error messages will be displayed saying "a newer version of GridView is required to open this file". 

Upgrading to this Version from 9.0D Upgrade Complexity:  Easy � 

If you want to add the automatic Styles (new feature) to an existing View, enable the option, then select 'Edit Definition' and press the 
OK button. The Styles will appear on the View. 

GridView  has a new program icon. To see the new icon you will need to edit the properties of any existing GridView shortcuts, click the 
Change Icon button and select the new image. 

The GETEXTERNALDATA function added in GridView 9.0C (2010.10.01) allows you to create composite views without using tables 
from the composite dictionaries, such as 'Adagio {Composite Tables 9.0A}' (@Z90A), which are no longer required or maintained. 
GridView no longer installs the composite dictionaries (@Z80C, @Z90A, @Z90B). If they already exist, they are not uninstalled. Any 
views using the composite dictionaries should be updated to use the new function instead. 

Upgrading to this Version from earlier versions  Upgrade Complexity:  Intermediate � 

Views and Workspaces created with earlier versions can be used with 9.1A and will be automatically converted. Some adjustments may 
be required, as described below. Views and Workspaces created with 9.1A cannot be used in earlier versions. If you open a 9.1A 
View with an earlier version of GridView an error message is displayed (for example: 'MyViewName.gv' was created with a newer 
version of GridView. A newer version of GridView is required to open this file.). 

If you have a View that was saved as Summarized in a prior version of GridView and when you refresh the View in GridView 9.0F the 
View is no longer Summarized, please do one of the following: 
 
(1) If the active filter is a ‘blank’ filter (i.e. filter formula box is empty), turn off filters by clicking the appropriate button in the toolbar. 
 
(2)If the active filter contains a formula, you need to do a couple of things. (a) Summarized Views have a field/column for which you 
have Set Sort Sequence. This needs to be set up as a Sort Sequence within the Edit menu. You need to Edit | Sort Sequences for that 
View, expand the tree and select that field as the sort sequence. Then, (b) Edit | Filters and select that Sort Sequence and enable the 
Summarize option. 
 
After doing steps (1) or (2) above, make sure you save the affected View and, if the View is part of a Workspace, save the Workspace. 
Now, it won’t matter if you use the Refresh on Open option or F9, the View will remain Summarized. 

-- end -- 


